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INTRODUCTION 
 
This is a practical guide to the use of Adobe Audition for the basic 
user.  It will include ONLY the basic aspects of recording to and 
playback from Audition and not the more complex features of the 
program. 
 
Everyone will use adobe Audition to record her or his own program 
for rebroadcast and archival storage.   
 
This manual is set up in 5 Sections: 
 

• BASIC SCREEN SET-UP – which describes the appearance of 
the screen when you open the program 
 

• RECORDING – which describes the basic procedures for 
recording on the program and saving that recorded program 

 
• EDITING – which describes the basic ways you may want to 

edit what you have recorded before saving the file 
 

• PLAYING BACK – which describe how to play back recorded 
files 

 
• EXAMPLES OF USE – which will go through a few examples of 

how you will use the Adobe Audition in recording your radio 
program. 

 
Double click on the Adobe Audition 3.0 icon to open the program. 
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BASIC SCREEN SET UP 
 
Once the screen opens up you should see the following windows 
open. 
 

 
 

• A window labeled “Files”   
o Shows the open file that is seen in the “Main” window 
o This window also includes some tools in the upper and 

lower left corners of the window.  At the basic level you 
will not need to use these tools. 

 
• “Main” shows the recorded signal (pale green in this illustration) 

that you are recording or playing back 
 

• “Transport” is your main controller of recording and playback of 
Audition files. 
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• “Time” indicates where you are in the audio file, with the 
beginning of the audio file being 0:00.000, in 
minutes:seconds.thousandths of seconds. 
 

• “Zoom” is a way to control the scaling of the time axis and 
volume axis of the “Main” window. 

 
• “Selection/View” gives you two sets of time intervals:   

o “View” is the time interval of the recording that you see in 
the “Main” window based upon the scale you have set, 
again in minutes, seconds and thousandths of seconds. 
 

o “Selection” is the duration of any part of the recording 
you have selected with the selection tool (discussed later) 

 
o Each of these time intervals have “Begin”, “End” & 

“Length”.   
! In the illustration below you have not selected any 

area of the recording so “Selection” show no value 
for “End” or “Length”.  

! “View” shows “Begin” 0:00.000 and “End” of 
0:30.458 and a “Length” of 0:30.458.  This means 
you are seeing about 30.5 seconds of the recording 
in the “Main” window beginning at the beginning of 
the recording 0:00.000 

 

 
 
Window for “Levels” is at the very bottom, but you will not be paying 
much attention to this window and so is not highlighted in this 
illustration. 
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NOTE: If you do not see 
any or all of these windows 
click on “Window” in the 
top menu bar and add the 
missing windows. 
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RECORDING OF FILES 
 
You begin by clicking on the FILE tab in the top menu.  Drag the 
cursor down to NEW and click.  A new blank file will open and you 
can start recording in this file. 
 
For the channel or channels on the Audio Board that you wish to 
record from click the AUD button to record that channel into Audition.  
Move the POTS (potentiometer sliders) for the appropriate amplitude 
seen on the Audio Board VU meters.  The Audition meters should be 
now working showing the amplitude.   
 
The rules for amplitude: keep it above 10 decibels and just into 
the red area. 
 
In the Adobe Audition program click the RED record button in the 
Transport Window. 
 

 
 
A “New Waveform” screen will 
appear the first time you are 
making a new recording.  Make 
sure the default settings appear 
as: 

• 44100 sample rate 
• stereo channels 
• 16 bit resolution  

 



 7 

Click OK to start recording.  
 
Once you have gone through the “New Waveform” screen that will 
not be repeated in subsequent recording on this file.  So just click the 
red record button and you are recording.  
 
NOTE: Once you click OK on the New Waveform screen you are 
recording so have the microphone that you are using on or the other 
input ready to run or you will have silence on the recording.  If silence 
does occur, there is no need to panic as you will learn later how to 
remove silence from the recording. BUT, it is important not to have 
silence or dead air because it is disconcerting for the listener who 
may wonder if the station went off the air and they might tune into 
another station. 
 
To pause the recording, click on the pause button, the button with the 
double vertical lines. To return to recording you click the pause 
button again.  You would use the pause button if you have not set up 
the next song or if you forgot what you were going to say next. Again 
this would be used to prevent silence – or dead air. 
 
IMPORTANT:  If you click the RED record button after a pause the 
recording will return to the beginning of the most recently recorded 
section and start to rerecord over what you have already recorded.  
YOU DO NOT WANT TO DO THIS as you will lose what you had 
previously recorded. 
 
To stop recording, click the stop button, the square black button.  
You should do this only at the end of a recording session. 
 
IMPORTANT:  Once you click the stop button in the Transport 
window you will return to the beginning of the most recently recorded 
section.  So if you click the red record button again you will be 
recording over what you just recorded. Again this is something 
you do not want to do as you will lose what you previously recorded.   
 
If you are pre-recording your show for broadcast later and have 
stopped the recording, you can add to the recording.   

• If you have stopped the recording and want to add to the end of 
that file you have already created you need to click the go to 
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file end button in the Transport window and move to the end 
of the file to start recording again.  

 

 
 

• Or you can mark the point you wish to start recording again if it 
is not at the end of the file you have just recorded by using the 
Time Selection 
Tool (illustrated 
here).  Then click 
the mouse after 
you have placed 
the cursor on the 
middle band 
between the two 
channels (lower 
illustration).  This will produce a 
dotted yellow line with a downward 
yellow arrow at the top and a 
upward yellow arrow at the bottom 
of the Main window.   This marks 
the new starting point in the file.  
Now you rerecord from this point 
on by clicking the RED record 
button.  If in the future you click on 
the stop or record buttons you will 
return to this point in the file 
timeline. 
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NOTE: You do not need to concern yourself with the levels you 
see on the software as very high levels are not distorted.  Most 
important are setting the proper levels on the Audio Board using 
the POTS. 
 
SAVING THE RECORDED FILE 
 
When you have finished recording click on the stop button.  To save 
the recorded file, click on the “FILE” tab of the top menu.  Drag the 
cursor down to SAVE AS and click.   
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The first time you save this file a new window will appear: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• At the top of the window you will see the most recent folder to 
which a file had been saved.  In this illustration it is the folder 
for the saving of music shows on WRUU  
C:\Users\WRUU\Music.  For Talk shows the folder to use is 
C:\Users\WRUU\Talk.  
 

• Next you see the folder that this recording is to be saved into 
which is “My Music”.  If you click on the downward arrow at the 
end of that box you will see the directory of files and see that 
My Music is in the folder WRUU on the desktop.  Below this 
window you will see all of the other files in that folder. 

 
• The next area in this window is the place where you name the 

file.  Here you will type in the file name using the naming 
convention described below. 

 
• Below that is the file format in which you are saving the file.  At 

present we all will be using Windows PCM or .wav file because 
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they have a higher fidelity than some other compressed formats 
(such as .wp3) 

 
 
NAMING CONVENTION 
 
When saving files the name should include a brief show title and the 
first air date.   For example the Baker’s Dozen of Blues which first 
aired on September 22, 2015 would have the file name:  
bakers_dozen-9.22.15.wav 
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EDITING FILES 
 
ADDING TO THE RECORDING 
To add new material at the end of your recording, go to the end of the 
file and click the red record button.  The easiest way to get to the 
end of the file is to click the go to file end button in the Transport 
window. 
 

 
 
 
DELETING FROM THE RECORDING 
 
If you are thinking of deleting a portion of the file you have recorded, 
listen to the recording and record the starting point and ending point 
that you want to delete.   
 
Lets say a guest on your program made a statement that is contrary 
to the station philosophy or inappropriate to air on the station or your 
discussion with the guest is running to long for your time slot.  Listen 
to the program and see in the View/Selection window what the time 
in the recording that the section you wish to delete is.  Record that 
time.  Continue to listen and note the time in the recording that is the 
end of that selection you wish to delete. 
 
To delete this section from the recording: 

• Click the Time Selection Tool (on the second menu from the 
top).  
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• Click the “main” screen half way between 
the two channels at the beginning of the 
time you wish to delete and while 
maintaining depression on the mouse 
drag along to the end of the time that you 
want to delete.  
 

• Once that time period is highlighted 
(background appears white and waveform 
is black), hit the play button in the 
transport window to make sure this is 
what you want to cut. 
 

• Then either:  
o Click the scissors button on the 

third menu from the top OR  
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o Click on Edit in the top menu and drag the cursor down to 
“CUT” and click. 

 
You will notice on the Edit 
menu that “Enable 
Undo/Redo” should be 
highlighted just in case you 
have second thoughts on 
what you have cut.   
 
Because if “Enable 
Undo/Redo” is highlighted, at 
this point you can go back 
into the Edit menu and click 
on “Undo Cut” to return to 
the main screen the cut 
portion of the timeline. 
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USE OF ZOOM TOOL 
 
To do your editing you may wish to get a 
closer view of the section of the 
recording you wish to delete.   
 
You need to expand the time scale in the 
Main window.  You do this by clicking on 
the  + (plus) magnifying glass symbol 
with horizontal arrows in the Zoom 
window.  You can hit this multiple times 
to get even more detailed time views 
(shorter time periods in the window).  
 
To return to the original view click the – 
(minus) magnifying glass symbol. 
 
 
DELETING SILENCES 
 
One thing that will be commonly deleted is silences between thoughts 
while you are talking or between a description of a song and playing 
that song.  These silences can be removed universally or in just one 
area of the recording.   
 
NOTE: Be careful when considering deleting silences or other 
material because it obviously affects the length of your show, which in 
turn affects the timing of station IDs, airing of PSAs, and other 
programmed announcements. Work with the Program Log manager 
or your respective Program Team leaders. 
 
For removing silences from the whole audio file  

• Do not highlight any part of the audio file in the main window 
 

• Click on Edit in the top menu and drag the cursor down to and 
click on Delete Silence. 
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• On the window that pops up you need to define “silence” and 

“audio” in terms of volume and duration.   
o Most commonly between -50 and -60 decibels are used 

as the cut-off points for “silence” and “audio”.  Make sure 
that the definitions do not overlap.  For instance if you set 
“silence” for a signal below -56.5 decibels, the setting for 
“audio” should be above -56.4 decibels. 
 

o Durations are up to you but commonly silence is set to for 
more than 100 ms and audio is set to for more than 25 
ms.  

 
o Many may choose to adjust the duration of “silence” to 

longer durations to respect the pauses between voice and 
songs or between question and answer.  In the illustration 
above, the duration of silence is set at 500 msec or half a 
second. 

 
 

• Then click the “Scan for Silence Now” button to see how may 
silences are detected.  If there are more silences detected that 
you think should be detected, you can adjust the silence 
duration upward and if fewer than you expected you can shift 
the silence duration to a shorter duration. 
 

• Once you are satisfied with the number of silences to be 
deleted click on the OK button. 
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• And there is an Undo Delete Silences if you wish to have those 

silent periods back after you listed to your program again. 
 
IMPORTING FILES DIRECTLY 
If you wish to import files directly into Adobe Audition, the help menu 
indicates and the Open File menu would seem to indicate that any 
format of audio files can be imported.   
 
However from working with Audition, it appears that .wma files are 
the only ones that can be consistently opened directly into the 
software.  These are Windows Media Audio files. 
 
Click on the File tab in the top menu, and drag the cursor down to 
and click on “Open File”.   
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PLAYBACK OF FILES 
 
As previously mentioned, the playback of recorded files is 
accomplished in the following manner: 
 

• Click on Files from top menu 
 

 
 
 
 
 
 
 
 
 
 

• Drag the cursor down to OPEN and click 
 

• A screen similar to the one you saw when saving a file will open 
to allow you to locate your file.   

o Music shows have been saved in 
C:\Users\WRUU\Music  

o Talk shows have been saved in C:\Users\WRUU\Talk 
 
Once you have opened the file just click the PLAY button in the 
Transport window.  To pause the file click the PAUSE button and to 
stop playback click the STOP button. 
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A short cut: If you hit the space bar on the computer keyboard, the 
recording will pause.  Hit the space bar again and it will start playing 
again. 
 
IMPORTANT: To stop and then resume playback you will be primarily 
using the PAUSE button.  

• Clicking PAUSE stops the playback and when you click the 
PAUSE button again playback resumes from the point along 
the playback timeline at which you have paused.  
 

• Remember if you click STOP the file will no longer be at the 
point along the play timeline where you were when you clicked 
STOP.  If you click STOP the playback will resume at one of 
three places: 

 
o The beginning of the audio file (playback timeline) if you 

are still on the first timeline display in the Main window 
which still shows the beginning of the playback timeline. 
 

o The time point at the beginning of the present display of 
the Main window.  As you progress along the timeline the 
main window will display where you are along the 
timeline.  The timeframe displayed in the Main window is 
seen in the “View” section of the “Selection/View” window 
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o The time point along the timeline that you have selected 
using the Time Selection Tool (on the second menu from 
the top).  Click the Time Selection Tool and then click the 
main screen at a point half way between the two channels 
displayed to select a specific time along the time line 
 
 
 
 
 
 
 

This point will be seen as small yellow arrows at the top 
and bottom of the Main Screen with a dotted line between 
them. 
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To listen to the audio, use A: Editor channel on the Sound Board and 
hit the AUD buttons on both the A: Editor channel and Studio 
speakers/headphone channel. 
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EXAMPLES OF USE OF ADOBE 
AUDITION 
 
This section of the manual will provide some examples of how the 
Adobe Audition software can be used for shows of different types.   
 
Your show needs to be recorded for archival purposes and later 
playback.  
 
Note that at the time of the writing of this manual, it has not yet been 
determined how public service announcements (PSAs) or station 
identification will be done.  If these are pre-recorded, they will have to 
be added to the recording in some way, again which has yet to be 
determined. 
 
TO RECORD A LIVE PROGRAM WITH 1 SPEAKER 
 
Set up Adobe Audition: 
 

1. Open Adobe Audition by clicking on the desktop icon on the 
computer monitor. 

2. Clicking and hold down the “FILE” tab in the top menu.  
3. Drag cursor to “NEW” and click. 
4. A “New Waveform” screen will appear the first time you are 

making a new recording, and it will be sitting on top of the 
new file window.  
The default settings should be:  
 — 44100 sample rate,  
 — stereo channels &  
 — 16 bit resolution.  
Click OK after ensuring these default settings. 

5. Now the new blank file will appear and you can start 
recording in this file. 

 
Set up the audio board: 
 
On the Audio Board,  

1. Hit the ON button for A: MIC #1 channel.  
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2. Hit the AUD button to record that channel into Adobe Audition 

AND hit the PGM button to go on-air.  
 

3. Move the POT (slider) for the appropriate amplitude for 
broadcast seen on the Board’s VU meters (note the gray 
“squares” and “dots” that approximate a good location, but it 
really depends on the volume of your voice and your distance 
from the microphone). Both the Program and Audition meters 
should be now working together showing the amplitude.  

 
4. With the microphones switched on you will have to wear 

headphones on to hear the program being recorded and 
broadcasted. You will have both AUD and PGM buttons 
pressed (activated with light “on”) on the Speakers/ 
Headphones channel located at the far right on the board. 

 
Now Back to Adobe Audition 
 

1. In Adobe Audition, click the RED record button in the Transport 
Window (near middle, bottom of interface). And you are now 
recording. 

2. Start your show: start talking or playing your music intro. 
 

3. Click the STOP button in the Transport Window when the show 
is over.  

 
Remember all silences in your show will be recorded. You may 
choose to remove those silences if you edit your recorded program, 
BUT this will shorten the recorded program from its original length 
and can affect the “over and under” timing of your show relative to the 
timing for station IDs, PSAs, promos, and underwriting 
announcements. 
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LIVE PROGRAM  
WITH 2 OR MORE SPEAKERs 
 
Set up Adobe Audition: 
 

1. Open Adobe Audition by clicking on the desktop icon on the 
computer monitor. 

2. Clicking and hold down the “FILE” tab in the top menu.  
3. Drag cursor to “NEW” and click. 
4. A “New Waveform” screen will appear the first time you are 

making a new recording, and it will be sitting on top of the 
new file window.  
The default settings should be:  
 — 44100 sample rate,  
 — stereo channels &  
 — 16 bit resolution.  
Click OK after ensuring these default settings. 

5. Now the new blank file will appear and you can start 
recording in this file. 

 
On the audio board: 
 

1. Hit the ON buttons for A: MIC #1 AND A: MIC #2 channels. 
 

2. Hit the AUD button to record that channel into Adobe Audition  
AND hit the PGM button to go on-air.  

 
3. Move the POTS (sliders) for the appropriate amplitude for 

broadcast as seen on the Board’s VU meters (note the gray 
“squares” and “dots” that approximate a good location, but it 
really depends on the volume of your voice and your distance 
from the microphone). Both the Program and Audition meters 
should be now working together showing the amplitude.  

 
4. Put on headphones. With the microphones switched on you 

will have to wear headphones to hear the program being 
recorded and broadcasted.  
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5. Press ON both AUD and PGM buttons (activated with light 
“on”) on the Speakers/ Headphones channel located at the 
far right on the board. 

 
Now Back to Adobe Audition 
 

1. In Adobe Audition, click the RED record button in the Transport 
Window (near middle, bottom of interface). And you are now 
recording. 

2. Immediately, start your show: talking or playing your music 
intro. 

 
3. Click the STOP button in the Transport Window when your 

musical outro is over.  
 
Remember all silences in your show will be recorded. You may 
choose to remove those silences if you edit your recorded program, 
BUT this will shorten the recorded program from its original length 
and can affect the “over and under” timing of your show relative to the 
timing for station IDs, PSAs, promos, and underwriting 
announcements. 
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LIVE PROGRAM  
 WITH SPEAKERS AND  
 MUSIC INTRO AND OUTRO 
 
 Set up Adobe Audition: 
 

1. Open Adobe Audition by clicking on the desktop icon on the 
computer monitor. 

2. Clicking and hold down the “FILE” tab in the top menu.  
3. Drag cursor to “NEW” and click. 
4. A “New Waveform” screen will appear the first time you are 

making a new recording, and it will be sitting on top of the 
new file window.  
The default settings should be:  
 — 44100 sample rate,  
 — stereo channels &  
 — 16 bit resolution.  
Click OK after ensuring these default settings. 

5. Now a new blank file will appear and you can start recording 
in this file. 

 
On the Audio Board,  
 

1. Hit the ON buttons for the microphones: A: MIC #1 AND A: 
MIC #2 channels (the latter IF you have more than 1 speaker  

 
2. Hit the AUD button on each channel to record the channel(s) 

into Adobe Audition AND hit the PGM buttons to go on-air.  
 

3. Move the POTS (sliders) for the appropriate amplitude for 
broadcast as seen on the Board’s VU meters (note the gray 
“squares” and “dots” that approximate a good location, but it 
really depends on the volume of your voice and your distance 
from the microphone). Both the Program and Audition meters 
should be now working together showing the amplitude.  

 
4. Plug/attach your external music storage device you bring 

to the studio (e.g. iPod) into the AUX jack of the Sound Board. 
NOTE: If your music is stored on a CD/DVD, place it in 1 of the 
2 CD/DVD players that is already plugged in and sits in the 
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studio under both computer monitors; you can also temporarily 
store you music on a studio computer 

 
5. Turn ON the A:AUX JACK channel and slide the POT up for 

the appropriate amplitude for broadcast. 
 

6. Hit the ON buttons for both AUD and PGM for the A:AUX 
JACK channel.  

 
7. Put on headphones. With the microphones switched on you 

will have to wear headphones to hear the program being 
recorded and broadcasted.  

 
8. Press ON both AUD and PGM buttons (activated with light 

“on”) on the Speakers/ Headphones channel located at the 
far right on the board. 

 
Now Back to Adobe Audition 
 

1. In Adobe Audition, click the RED record button in the Transport 
Window (near middle, bottom of interface). And you are now 
recording. 

 
2. Start your show: start talking or playing your music intro. 

 
3. Click the STOP button in the Transport Window when the show 

is over.  
 
 For example: Your musical into and outro are on an iPod.  
 

1. The iPod is plugged into the AUX jack of the Sound Board  
 

2. The A:AUX JACK channel is ON and the POT is up for the 
appropriate amplitude for broadcast.  

 
3. Turn ON all the appropriate microphones and make sure they 

are set at their appropriate VU meter levels  
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4. In Adobe Audition, click the RED record button in the Transport 
Window (near middle, bottom of interface). And you are now 
recording. 

 
5. Play the iPod musical intro alone or with voice over (with the 

music volume lowered so listeners can also hear your voice)  
 

6. Hit the OFF on the A:AUX JACK channel 
 

7. Start talking within 3 seconds (no dead air, please) 
 

8. Play your musical outro when your talk is over. 
 

9. Click the STOP button in the Adobe Audition Transport 
Window when the your musical outro is over. 
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LIVE MUSIC PROGRAM  
 
Set up Adobe Audition: 
 

1. Open Adobe Audition by clicking on the desktop icon on the 
computer monitor. 

2. Clicking and hold down the “FILE” tab in the top menu.  
3. Drag cursor to “NEW” and click. 
4. A “New Waveform” screen will appear the first time you are 

making a new recording, and it will be sitting on top of the 
new file window.  
The default settings should be:  
 — 44100 sample rate,  
 — stereo channels &  
 — 16 bit resolution.  
Click OK after ensuring these default settings. 

5. Now the new blank file will appear and you can start 
recording in this file. 

 
Set up the audio board: 
 
On the Audio Board,  
 

1. Hit the ON button for A: MIC #1 channel.  
 

2. Hit the AUD button to record that channel into Adobe Audition 
AND hit the PGM button to go on-air.  

 
3. Move the POT (slider) for the appropriate amplitude for 

broadcast seen on the Board’s VU meters (note the gray 
“squares” and “dots” that approximate a good location, but it 
really depends on the volume of your voice and your distance 
from the microphone). Both the Program and Audition meters 
should be now working together showing the amplitude.  

 
4. With the microphones switched on you will have to wear 

headphones on to hear the program being recorded and 
broadcasted. You will have both AUD and PGM buttons 
pressed (activated with light “on”) on the Speakers/ 
Headphones channel located at the far right on the board. 
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For example: Playing music from CDs  
 

1. Place your CD/DVD in CD 1, which sits adjacent to the Audio 
Board under a computer monitor.  

 
2. Cue up the CD track that you want on the CD 1 player 

BEFORE going on-air.  
 

3. For the B: CD 1 channel, the ON button is depressed and the 
POT slider is moved up to the appropriate amplitude. 
Depending on the CD recording volume, the appropriate 
location for the POT slider might be just below the gray square 
gray dots on the POT slider.  

 
4. Click the RED record button in the In the Audition Transport 

Window. You are now recording your show for the archives and 
playback later. 

 
5. Do your voice introductions of the music, etc. through the A: 

MIC #1 channel  
 

6. Push PLAY on the CD 1 player. Adjust the POT slider for the 
B: CD 1 channel if needed. Pull the POT for A: MIC #1 down to 
0 or hit the OFF button on the A: MIC #1 Channel. 

 
7. Set up your next CD in CD 2 player and CUE the appropriate 

track.  
 
As you talk and as the music plays, adjust the POT sliders by 
watching the VU meter on the Audio Board. 

 
8. Assuming you wish to talk before and after each song, at the 

end of the first song, hit the OFF button on B: CD 1 channel 
AND hit the ON button or POT up A: MIC #1 to talk about the 
previous song and to announce the next song. 

 
9. Push PLAY on the CD 2 player. Adjust the POT slider for the 

B: CD 2 channel if needed. Pull the POT slider down for A: 
MIC #1 down to 0 or hit the OFF button on the A: MIC #1 
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Channel. 
 
Then repeat the cycle through all the songs in your show. 

 
10. Click the STOP button in the Adobe Audition Transport 

Window when the your musical outro is over. Remember, with 
the microphone ON, all silences will be recorded. You may 
choose to remove those silences in the recorded program BUT 
remember this will shorten the recorded program from its 
original length. 

 
Avoid dead air. 
 
 


